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EXECUTIVE MESSAGE

Catena Analytics offers powerful platforms for building accessible and scalable analytical tools and
simulation models that can be accessed via desktop or mobile devices. Our team has spent the last
decade developing the Environmental Resource Assessment and Management System (eRAMS), an
open source technology that provides cloud-based geospatially-enabled software solutions as online
services and a platform for collaboration, development, and deployment of online tools. Our
services are used to assist with strategic and tactical decision making for sustainable management of
land, water and energy resources. Thank you for choosing Catena Analytics and the eRAMS platform
to meet your data, modeling, analysis and geospatial needs.

WHO SHouLD USE THIS GUIDE

This guide is a tutorial to get you started using eRAMS and the Hydrologic Response Unit tool. The
guide provides instructions for commonly performed tasks and uses of the tool. This tool is intended
for use by urban planners and water managers, academic groups, regulatory officials, consultants as
well as state, local and federal agencies planning for the future of water resources.

NEED HELP?

After reviewing the guide if you need additional assistance we are here to help! This guide is
designed to provide instruction on commonly performed operations and answers to many frequently
asked questions. If you find any aspect of the tool challenging or missing information from this
guide, please engage an eRAMS expert to guide you through any hurdles. Contact us at:
eramsinfo@gmail.com
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INTRODUCTION

eRAMS
Map (’:" 0\.‘,}:: . L-\PD“
m =
» Settings Hydrology
» Base Layers Hydrologic Resgonse Units
» Public Layers Watershed Delineation
» Geospatial Layers | |Ganeral
» Placemarks
PURPOSE

@CATENA

ANALYTICS

Delincate Watershed

= Options

Basic option allows Users 10 run every too for watershed deineation automatically at once.
Advanced option alloy un ANy SpACINes 1ools With customized inputs, Watershed
Extraction option outputs a3 a polygon shapefile by running only necessary
$18p8 - ‘Move Outiets’ an d

® Basic Advanced Watershed Extraction

Sedect foider (optional Bl Create Foicer |

= Automatic

This tool runs every step in the advanced option automaticaly. The cutiet poits will be moved
[ hed Peuker Douglas stream pixels. 10 pixels will be used as a stream threshold If drop

ysis cant fnd the optimal value. The input DEM should be in a projected coordinate
system with the same untis of X, Y, and height Omerwise, the slope raster's unit should be
Interpreted as (unit of height) / (unit of X and Y)

Outiet point layer “Cnoose>

The Hydrologic Response Unit (HRU) delineation tool calculates HRUs as a vector format by

intersecting several input layers

DESCRIPTION

Hydrologic Response Unit (HRU) Delineation Tool creates HRUs based on soil, land use and slope
layers to calculate slope length, manning's overland flow coefficient, C factor and time of
concentration. The HRU layers include information on land use, hydrologic soil group, soil texture,
average slope, curve number, area, and perimeter. HRUs are calculated as adjacent and unique
combinations of pixels from input layers. Users can also merge smaller HRUs less than given
threshold to the adjacent and larger HRUs. This tool allows users to select from a wide variety of
prepopulated data inputs (NLCD, NASS CropScape, NASS Cropland, SSURGO).

SOFTWARE AVAILABILITY

Domain

https://erams.com/map/

Documentation URL

https://erams.com/catena/tools/river-basin-planning/hru/
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Publication/Citation

Kim, J. S., Arabi, M., Patterson, D. (2015). eRAMS Hydrologic Response Unit (HRU) Delineation Tool
[Software].

SYSTEM REQUIREMENTS

A modern web-browser is required to connect and run this tool. Browser options include: Google
Chrome v.69, Moxzilla Firefox v.62, Safari v.11.1, and Microsoft Edge v.17.

AUTHORIZED USE PERMISSION

The information contained in the Hydrologic Response Unit (HRU) Delineation Tool (the "Service") is
for general information purposes only. Colorado State University’s One Water Solutions Institute
("CSU-OWSI") assumes no responsibility for errors or omissions in the contents of the Service. In the
Service, you agree to hold neither the creators of the software platform nor CSU-OWSI liable for any
action resulting from use or misuse of the Service. In no event shall CSU-OWSI be liable for any
special, direct, indirect, consequential, or incidental damages or any damages whatsoever, whether in
an action of contract, negligence or other sort, arising out of or in connection with the use of the
Service or the contents of the Service. CSU-OWSI reserves the right to make additions, deletions, or
modification to the contents of the Service at any time without prior notice.
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USING THE TOOL

ACCESS THE TOOL

Public Access

The Hydrologic Response Unit (HRU) Delineation Tool can be accessed without registering an
eRAMS account. In the public-facing version the data and analysis will only be available for the
duration of the browser session. Once the browser is closed the project will no longer be available
(i.e. users cannot save their work or share their project).

If a user prefers to save their project, share it with collaborators or revisit their analysis, an account is
required. Follow the instructions below to create your free account and save your projects or visit
our website to get started: https://erams.com/account/

Create an eRAMS Account

1. From the eRAMS Registration page, select "Register Now" from the top menu and enter a
username, password, your first and last name, and your email address. Click “Create
Account”.

e eRAMS will display a popup box alerting you that an email confirmation has been
sent to the provided email address

2. Open the email account provided in the registration form from either a new browser window
or from your local email application.

e Search for an email from eRAMS with the subject line “eRAMS Email Check”

3. Open this email and click on the provided link to confirm your email address.

e Note: If you do not see the confirmation email appear in your email inbox
immediately, check your spam or junk email folder to ensure that the confirmation
message wasn't automatically discarded. You may also need to wait a few moments to
ensure the email is delivered successfully.

4. Once you click on the provided email link, you should be redirected to eRAMS, where you'll
be automatically logged in
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CREATE HRU LAYER

Modify Base Layer (optional)

With the GIS interface open, click the “Map” tab on the left dashboard

1. Select the “Base Layers” drop-down
2. Select the desired base layer
e Options include: None, Google, Bing or USGS National Map (Figure 1)

eRAMS
—
1, - 55 .
K $EQQARR PO B¢
\}
B .
» Settings |Zoom to: fort collins, co

~ Base Layers {ummm

None
OpensStreetMap
Google
Physical
Streets
Hybrid
® Sateliite
Bing
Road
Hybrid
Aerial
USGS National Map
Topo
Imagery Topo
Hydro-NHD
Shaded Relief

+ Public Layers
» Geospatial Layers

» Placemarks

Figure 1: Modify base layer in eRAMS geographic interface

Create New Layer

Figure 2 demonstrates how to activate the Hydrologic Response Unit (HRU) interface. User's are
presented with prompts to move through the workflow (described in greater detail below).

1. With the GIS interface open, click the “Map Tools" icon located along the top of the map
interface (Figure 1).

2. Select “"Hydrology” from the drop-down menu

Select "Hydrologic Response Unit” to open the analysis interface

4. Follow the workflow prompts described below

w
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eRAMS
Map
» Settings
Measure
» Base Layers
Geoprocessing
» Public Layers Geostatistics
» Geospatial Layers Extract Data
» Placemarks Digitize/Edit

Mutti Criteria Decision Analysis

Network Analysis . 2
i
Terrain Analysis ‘ ! Hydrology

Hydrology »

Hydrologic Response Units This tool creates Hydrologic Response Unit (HRU) based on sol, landuse and siope layers. Optionall, user
| can add more input layers. After HRU is created, user can add slope length, manning's coefficient, C factor
‘ Watershed Delineation BN  and time of concentration by clicking buttons. If user chaged landuser layer, soil layer should be rebuilt

Mol Bl Store results in folder.  <Choose>

Watershed Boundary. <Choose>
Land use, <Choose>
Soil <Choose>

Slope: <Choose>

User Layer (optional): <Choose>

Min area (% 5

Figure 2: Accessing the Hydrologic Response Unit interface

First, users are required to create a folder to store results and organize files needed for each HRU
delineation. It is highly recommended that users create separate folders for each HRU boundary. To
create a folder, select “New Folder” and enter a title OR choose location from drop down list if you
have already generated a folder.

After creation of folders, users need to define input boundary. This can be implemented in three
ways:

Option 1: Users can trace the watershed on the map by using the circle, rectangle or polygon tool.
Select “Build” and preferred drawing tool under “Option 1" (Figure 3). Users can draw circles,
rectangles or polygons using this tool.

Option 2: Alternatively, users can choose HUC polygons HUC 12, HUC10 or HUC 8 (Figure 3-2a),
then select any HUC available in the drop down list (Figure 3-2b).

Option 3: The last way to define the input boundary is to upload your own polygon vector data.

m

After the HUC polygon selection has been made, press
displayed on the map.

Go" and the resulting HUC layer will be
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Create Hydrologic Response Unit (HRU) Layer

This tool creates Hydrologic Response Unit (HRU) based on soil, landuse and slope layers. Optionally, user can add more input layers. After HRU is created, user can add
slope length, manning's coefficient, C factor and time of concentration by clicking buttons. If user chaged landuser layer, soil layer should be rebuilt

Store results in folder: HRU Data: 20 Nov 2019_12:19:3 v New Folder

=) Option 1: Trace the watershed on the map

Draw Tool: Circle Rectangle Polygon

Option 2: Use predefined NHD Hydrologic unit catalog: 2c.
2a. mmm) [<Sclect vl 2b. v Go
<Choose>
HUC 12 Big Thompson Canyon-Big Thompson River (101900060603)
HUC 10 Boyd Lake-Big Thompson River (101900060605)
HUC 8 City of Fort Collins-Cache la Poudre River (101900070805)
Land use ~CTUST™

) | Douglas Reservoir-Dry Creek (101900070804)
| Fossil Creek Reservoir-Cache la Poudre River (101800071002)

Soil <Choose> | Horsetooth Reservoir (101900070802)
| Lower Boxelder Creek (101900070905)
Slope: <Choose> Lower Buckhorn Creek (101900060304)

| Oklahoma Reservoir-Cache la Poudre River (101900071005)
| Redstone Creek (101900060303)

User Layer (optional) <Choose> Timnath Reservoir (101900071001)
| Windsor Reservoir (101900071003)

Min area (%): 5

oD I TS

Figure 3: Selecting a watershed boundary

User can select either National Land Cover Database (NLCD) (MRLC, 2016) or NASS CropScape and
Cropland Data Layer (CDL) (USDA, 2016). Both layers have Albers Equal Area projection and 30m
GSD. Currently, HRU delineation tool provides NLCD 2001, 2006 and 2011 and NASS CDL from 2003
to 2014. See Figure 4 for examples.
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Dt Crop WinWheCom

- Furgns
W Dts Crop WinWre'Sorghum

Figure 4: NASS 2014 CDL (left, unclipped) and NLCD 2011 (right, clipped by boundary)
Soil

eRAMS HRU delineation tool provides Soil Survey Geographic (SSURGO) (USDA, 2016) data to
generate a soil layer. The SSURGO polygon layer is clipped by boundary and converted to rasters
using gdal_rasterize (GDAL, n.d.) using mukey as pixel values.
According to USDA (2012), the purpose of mukey in SSURGO
database is to link map unit boundary spatial record to the
corresponding map unit table record. Figure 5 shows the example
of soil raster layer created using HRU delineation tool in eRAMS.

'sburg

Kingman

Slope

The slope layer is created using ‘gdaldem’ (GDAL, n.d.) with
NHDPIlusV2 (US EPA, 2015) DEM. ‘gdaldem’ is the tool for analysis
mo0-on - and visualization of DEM. (GDAL, i

- W 0.01-001 S S
4 0.01-002 Soil: Panther Creek-Sugar Mill Creek

w00 N.d.) and NHDPlus is a geospatial el
EEEEE and hydrologic framework dataset o s
®oxo® created by US EPA with assistance Figure 5: Soil layer example
of USGS (US EPA, 2015). Since
gdaldem outputs slope layer with percentage unit, the value of pixels
were divided by 100 using gdal_calc.py (GDAL, n.d.). Figure 6 shows

the example of Slope layer created in eRAMS HRU delineation tool.

~

{ingman

Fiil

User Layers

?2 Users can also add any raster layer by clicking the “Add” prompt and
2

selecting the desired layer. To remove a user layer, simply click the

Figure 6: Slope layer example "x" at the end of the layer name.

- 71 0\ - Turkey Run

Note: it may take longer to complete delineation of HRU if user adds multiple ‘User Layer(s)".
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HRU Delineation

After the desired watershed boundary, land use, soil and slope have been identified, click “Create” to
generate the HRU output layer.

First, the slope layer is reclassified to 5 classes since there are too many unique values of slope. Using
‘gdalinfo’ (GDAL, n.d.), the maximum and minimum slope values are extracted, the difference is
calculated and the interval is estimated by dividing the difference by 5. Then, each class is defined by
the average of minimum and maximum of each class.

After slope layer is reclassified, the input layers are intersected and unique pixel combinations are
calculated using gdal_combine (Toney, 2016). The output raster from gdal_combine is convereted to
polygons by gdal_polygonize (GDAL, n.d.). When using gdal_polygonize, eight direction option was
included to define surrounding eight pixels as adjacent pixels (default is four directions). The output
polygon layer was masked by boundary layer in this step not to clip vectors in later step using SQL,
which is computationally expensive for a large number of rows.

After getting HRU polygon vector, the required information is added to the table of HRU layers
which includes landuse code (landuse), mukey (mukey), slope (slope), landuse string (landuse_str),
hydrologic soil group (hydgrpdcd), soil texture (texture), curve number (curve_no), area (hru_area)
and perimeter (hru_perimeter).

The table can be viewed by selecting “Geospatial Layers” from the left dashboard then right-click on
the desired layer and select “Open Attribute Table” (Figure 7).

eRAMS
*
Map < o )
s e 5 K - T TAW - aay
g+ { ; " W
» Settings 312 Zm to: fort collins, co %
ol b s
» Base Layers F ‘ ] : A
» Public Layers l % % S":a‘ ] M
i N }
) Geospatial Layers |
) & Spatial Layers | 4 HRU_City of Fort Collins-Cache la Poudre River_1574280185222
= W HRU_City of Fort Collins-Cache a Poudre f\{ ¥
Tumn Labels On i b gid dn landuse landuse_str mukey hydgrpdcd texture slope curve_no hru_area hru_perimeter slope_length (m)
mmm—) Open Atiribute Table plins-Cache la Pouc | 1 2 152 Shuubland 152 137629999 449957 350.039 390483
& M| Zoom To Layer | 121937 M 2 2 152 Shrubland 152 13762 0009 179983 17952 224963
Deiad [ 12:16:32 5’ 3 3 142 EvergreenForest 142 137629999 179983 180.476 21223
Tobies) ERRLAH X £ :ﬁ 4 4 190  Woody Wetiands 190 183420999 899913 119.98 15.0074
= a":; et S—— - 5 1 176  GrassPastre 176 137620999 899913 119.998 424264
) ekt 3 6 3 142 EvergreenForest 142 13762-9999 899913 119.998 21223
R » (P I 4 190  Woody Wetlands 190 183429999 899913 119.998 212236
Copy = o
» Placemark o .o l‘ g 8. 5 s Hobscoous 195 183420099 899913 119.998 724412
Add To Placemarks g;'\ 9 4 190  Woody Wetlands 190 183429999 719931 509.036 587206
S LHE 10 3 142 Evergreen Forest 142 137629999 899913 119.998 30,0147
&3
Properties £
Metadata
&
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The landuse code, mukey, slope are added directly from the pixel values of input layers. Then
landuse string is read from landuse table in eRAMS and added to HRU table. Hydrologic soil group
and soil texture are read from SSURGO database by joining component, chorizon and chtexturegrp
tables. Chorizon table includes components’ data by horizon and component table includes map unit
components’ interpretations and properties (USDA, 2014a). Chtexturegrp includes the texture ranges
for the horizon as a concatenated value of horizon texture and texture modifier(s) (USDA, 2014b). It
should be noted that soil horizon data only at the surface (hzdept_r=0) was used for determining
hydrologic soil group and soil texture. After hydrologic soil group is determined, curve number is
read from look up tables which relate landuse code, hydrologic soil group and curve number.

If user adds optional User Layers, the values of user layers will be assigned to the column, which is
named of layer name (excluding file extension, space of colon, if any).

Optionally, user can choose to add small HRUs to adjacent large HRU polygon. If any HRU polygon is
1) less than the given threshold; and 2) adjacent to any polygon larger than given threshold, the
small polygons will be unioned to the larger polygons. To implement this, the adjacency is defined as
the distance less than 9.259 x 1.0e-6 degree (approximately 1m). The distance between each HRU
polygon is checked using PostGIS (PostGIS, 2016) function ST_Distance (). Next, small and large
polygons are unioned using another PostGIS function ST_Union(). Figure 8 shows the cases with or
without minimum area threshold (1%).

Figure 8: Examples of HRU polygons (left: without minimum area threshold, right: with minimum area threshold [1%)]).
Optional Columns

After HRU polygons are calculated, slope length, Manning's roughness coefficient (n) for overland
flow, C factor, and time of concentration can be calculated by pressing corresponding buttons in the
HRU layer interface (Figure 9).
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» Settings
» Base Layers

{ Create Hydrologic Response Unit (HRU) Layer
» Public Layers

This tool creates Hydrologic Response Unit (HRU) based on soil, landuse and slope layers. Optionally, user
» Geospatial Layers 4 4 a can add more input layers. After HRU is created, user can add slope length, manning’s coefficient, C factor
A and time of concentration by clicking buttons. If user chaged landuser layer, soil layer should be rebuilt

Store results in folder: | HRU Data: 20 Nov 2019_12:19:3' v
Watershed Boundary: = City of Fort Collins-Cache la Pouc ¥ m
Land use: NASS][2016]: City of Fort Collins-( v m
Soil NASS[2016]: City of Fort Collins-( v

» Placemarks

Siope NASS[2016]: City of Fort Collins-( v

User Layer (optional): = <Choose> v Add

= Min area (%) 5

« HRU_City of Fort Collins-Cache la Poudre River_1574280185222 *

1 T 1

L

"
SO iy

Figure 9: Optional columns in HRU layer interface

Time of concentration (Tc) is the time for rainfall at the hydraulically most remote location in the
watershed to reach the outlet point(Wurbs and James, 2002) and it is calculated using equation (1)
according to USDA (2002). In equation (1), cn’ is retardance factor, which can be substituted by Curve
Number (USDA, 2002). The slope length, curve number, slope layers are extracted for defined
boundary in eRAMS and they are used to calculate Tc.

1985+ )07

1,140¥0-3 Eq (1)

C

where [ is flow length,

] . : . 1000
§is maximum potential retention = (—-— 10,
cn

Yis the watershed slope.

The other options, including slope length, Manning's roughness coefficient (n) for overland flow, C
factor are calculated using CSIP services, which are described in detail as in the Appendix.
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SLOPE LENGTH

Summary

This tool calculates the average slope length of each feature in a polygon vector layer. If a user
defines the boundary, NHDPlus V2 DEM (US Environmental Protection Agency, 2015) is clipped using
GDAL Utility — gdalwarp (GDAL, n.d.) and input to Taudem'’s “pitremove” module (Tarboton, 2014) to
create DEM without sinks. Next, flow direction raster is calculated by Taudem'’s “d8flowdir” module.
And slope length raster is calculated by Taudem’s “gridnet” module. According to Hickey (2000), 50%
slope decrease ratio was set as the criteria for cutoff pixel, where slope length should be reset to
zero. It is implemented by replacing flow direction value at cutoff pixel with nodata value (-32768)
before running Taudem's “gridnet” module. For the starting pixel (where slope length was calculated
as zero until this step), the slope length was calculated as each 1/2 of pixel resolution for horizontal
or vertical flow direction pixels and sqrt(2)/2 of pixel resolution for diagonal flow direction pixels.
Finally, the average slope length for each feature is calculated using python program — zonal_stats
(Python Software Foundation, 2015). Above procedures are implemented as a service in CSIP (David
et al., 2015) environment.

Example

Figure 10 shows the table of polygon layer, whose slope length were calculated and appended in the
column - slope_length(m).

Layer Attribules

subwatershed.shp

tion Total rows: 9 Page nos 1 /1 Page size: 10 -

gid diny slope_length (m)

SR TR T ST R

@
o

a
@

Al Salected Mac Min: Sum: Awg:

Figure 10: Example of slope length values added to polygons layer
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Calculate Slope Length

From toolbox menu, choose Hydrology > Terrain Analysis, and Slope Length (Figure 11). In the
interface choose input layer for ‘Polygon’. Optionally, a user can create polygon or choose a HUC12
polygon by clicking ‘Build” button. After choosing input polygon layer, click ‘Calculate’. The average
slope will be appended to the attribute table of input feature as shown above (Figure 10).

» Settings

1 Measure

» Base Layers
Geoprocessing 3y
» Public Layers | |Geostatistics :

» Geospatial Layers

d
- |
| Exiract Data
» Placemarks i
|
J

Digitize/E dit N A %
Network Analysis | Slope

X

|

¥

 E | E——

| “Hyarology LS factor

W R T IRS AN | | So¥ Topography Index

Topography Index

Slope Length Tools

This tool estimates average siope length of a polygon. User can upioad a polygon shapefile or define a polygon
in this user interface.

Store results in folder. <Choose> v New Folder
Polygon <Choose> v Calculate

Figure 11: Access slope length interface
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API Notes

slope_length

The input data is polygon shapefile, which defines input boundary. .shp, .shx and .dbf files should be
posted.

Input/Output Parameter Description

{

“metainfo”: {

2

“parameter”: [

“name”: “boundary”,”value”: “polygon_boundary.shp”},
Input JSON request JSON {‘'name’: ’r’, ‘value’: x_max]},

{'name’: ‘I, ‘value’: x_min},

{‘'name’: ‘b’, ‘value’: y_min},

{'name’: t’, ‘value’: y_max}

]

}
plen tif Slope Length Raster
Output dir_cut tif Cutoff Flow Direction Raster
results csv Zonal statistics of slope length
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Summary

This tool estimates Manning’s overland flow roughness coefficient (n) based on NLCD landuse layer.
This tool was created in CSIP (David et al.,, 2015) environment. The look up table for NLCD landuse
classes and n was created in the python code inside CSIP service. The relationship between n and
NLCD landuse layer was established according to the research of Kalyanapu et al. (2010) except non-
available classes such as ‘Dwarf Scrub’, ‘Sedge/Herbaceous’, ‘Lichens’, ‘Moss’ and ‘Cultivated

Crop’. The n of ‘Shrub/Scrub’ class was used for ‘Dwarf Scrub’ class and the n of
‘Grassland/Herbaceous’ was used for ‘Sedge/Herbaceous’, ‘Lichens’, ‘Moss’ classes because they are
under same super classes. For the ‘Cultivated Crop’ class, n was determined as 0.04, which was used
for normal mature field crops in cultivated area from Hydraulics Design Manual of Oregon
Department of Transportation and Highway Division (2014) . Once Manning's coefficients are read
from look up table for each NLCD class, the average for each polygon is calculated by zonal_stats
(Python Software Foundation, 2015).

Example

Figure 12 shows the Manning's roughness coefficient for overland flow calculated for each polygon
features and added to boundary polygons vector layer table.

Layer Attributes
subwatershed.shp
Options  Totalrows: 8@ ' ** Page no. 1 1 Page size: 10 « " ° Save LUnde
gid - dn manming

1 0.0533868
2 4 00898725
3 1 P—

4 -] 0.0829824
5 1 0.0472443
8 3 0.0498521
7 ] 0.0567008
] 0.0893856
] 7 0.0885221

All Selecled M Min: Sum: Avg

Figure 12: Manning’s overland flow roughness coefficient

Calculate Manning's Roughness Coefficient

1.

Click the toolbox icon > Hydrology > General and select "Overland Manning's” (Figure 13). Follow
the prompts to create user folder, select or create boundary layer, create NLCD land use layer and

click 'Calculate’ (Figure 14).
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eRAMS
Map
» Settings I \ : .
» Base Layers =
Geoprocessing A
» Public Layers Gecctalistics Hydrology

A Hydrology

Hydrologic Response Units General

» Geospatial Layers Extract Data

D Watershed Delineation
Placemarks Digitize/Edit Curve Number

General i | |
Multi Criteria Decision Analysis _ Overland Manning's

Network Analysis C Factor

Terrain Analysis

Overland Manning's coefficient Tools

This tool estimates overiand manning's roughness coefficient for a defined polygon. User can upload polygon
shapefile or define polygon.

Watershed Boundary: <Choose>

Land Use (NLCD): <Choose>

Calculate

Figure 13: Access Manning's Roughness Coefficient interface

Overland Manning's coefficient Tools

This teol estimates overland manning's roughness coefficient for a defined polygon. User can upload
palygon shapefile or define polygon.

Store results in folder: Manning: 16 Jun 2016_15:12:19113 <:= 1. working folder
Watershed Boundary:  subwatershed.shp E| <:: 2 Boundary Iayer
1]

LandUse (NLCD):  NLCD[2011] subwatershed shp =] <= 3. Build button for landuse layer
|
NLCD  [+] 2011 [=] </ 4. Create landuse layer

Calculate

Close

Figure 14: User interface of Manning's Coefficient tool

API Notes

manning

The input data are landuse raster(.tif) and boundary polygon shapefile. For boundary polygon
shapefile, shp, .shx and .dbf files should be posted.

Input/Output Parameter Type Description
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{

“metainfo”: {

|3

“parameter”: [
“name”: “landuse”,

“value”: “landuse.tif"},

Input JSON request JSON {
“name”: “boundary”,
“value”: “polygon_boundary.shp”
}
]
}

Output Results csv zonal statistics of manning’s n
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C FACTOR

Summary

This tool estimates C factor (runoff coefficient) based on NLCD (MRLC, 2016) landuse layer. C factor
(runoff coefficient) is the essential parameter for calculating peak discharge from rainfall intensity
and watershed area. Most C factor values for NLCD classes (except classes — ‘Perennial Ice/Snow’,
‘Dwarf Scrub’, ‘Sedge/Herbaceous’, ‘Lichens’, ‘Moss’) were decided based on Dhakal et al.(2012)'s
research. The C factors of unavailable classes were chosen from the C factors of the classes under the
same super classes (C factor of ‘Shrub/Scrub’ class was used for ‘Dwarf Scrub’ class and C factor of
‘Grassland/Herbaceous’ was used for ‘Sedge/Herbaceous’, ‘Lichens’, ‘Moss’ classes). However, C
factor for ‘Perennial Ice/Snow’ is not available. The lookup table for C factor and NLCD classes were
created in python code in CSIP (David et al., 2015) service. If there are multiple polygons in input file,
C factor values will be assigned to each polyon by zonal_stats (Python Software Foundation, 2015).

Example

Figure 15 shows the c factor calculated for each polygon in input boundary vector layer.
Subwatershed vector layer was used as an input layer.

¥y

Figure 15: Input boundary vector layer (subwatershed polygons — left, each color represents multiple (3 or 4)
subwatersheds) and C factor (right) calculated for each polygon
Calculate C Factor

Click the toolbox icon > Hydrology > General and select “C Factor” (Figure 16). Follow the prompts
to create user folder, select or create boundary layer, create NLCD land use layer and click ‘Calculate’
(Figure 17).
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eRAMS
Map [X]PE QAR 2R ¢
“ ¥
™
» Settings i '

Measure

Base Layers A
Geoprocessing o
= Hydrology
Public Layers Geostatistics 5
Hydrologic Response Units SRR Dok

Geospatial Layers Extract Data r General

Watershed Delineation
Placemarks Digitize/Edit Curve Number

Multi Criteria Decision Analysis Overiand Manning's

Terrain Analysis

Hydrology »

}

C Factor Tools

This tool estimates C factor (Peak Runoff Coefficient) for a defined polygon. User can upload polygon shapefile
o define polygon

Store results in folder.  <Choose> v

Watershed Boundary. <Choose>

Land Use (NLCD) <Choose>

Figure 16: Access C Factor user interface

This tool estimates C factor (Peak Runoff Coefiicient) for a defined polygon. User can upload polygon
shapefile or define polygon

Store results infolder:  C_factor: 21 Jun 2016_8:40:32/ [<] <: 1. Working folder

Watershed Boundary: subwatershed.shp [=] <: 2. Boundary layer

LandUse (NLCD)  NLCD[2011} subwatershed.shp ] <: 3. Build button for landuse layer
|

<::| 4, Create landuse layer

NLCD  [+] 20M

Figure 17: C Factor user interface
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API Notes

cfactor
The input data are landuse raster(.tif) and boundary polygon shapefile. For boundary polygon
shapefile, shp, .shx and .dbf files should be posted.

Input/Output Parameter Type Description

{

“metainfo”: {

|3

“parameter”: [
“name”: “landuse”,

“value”: “landuse.tif"},

Input JSON request JSON {
“name”: “boundary”,
“value”: “polygon_boundary.shp”
}
]
}
Output Results csv zonal statistics of c factor
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